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Certification Information

Certification Information

F.C.C. INFORMATION TO USER

This unit has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 (Subpart B) of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference when the unit is operated in a commercial environment. This
unit generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this unit in a
residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at his own expense.

WARNING

Changes or modifications not expressly approved by EXFO
Electro-Optical Engineering, Inc. could void the user’s authority to
operate the unit.

» Shielded remote I/O cables, with properly grounded shields and metal
connectors, are recommended to be used in order to reduce radio
frequency interference which may emanate from these cables.

INDEPENDENT LABORATORY TESTING

This unit has undergone extensive C € certification testing both
internally, at EXFO, and externally, at an independent, qualified laboratory.
All pre-qualification tests were performed at EXFO while all final tests were
performed at UltraTech Engineering Labs, Inc., a renowned test laboratory
from Mississauga, Canada. This guarantees the unerring objectivity and
authoritative compliance of all test results.
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Certification Information

C E INFORMATION TO USER

This unit has been tested and found to comply with the limits for a Class A
digital device. Please see the Declaration of Conformity.
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1 Introduction

Presenting the FTB-300 Universal Test System

As communication technologies are evolving rapidly, testing requirements
are also becoming more complex and diversified. In response to this, the
FTB-300 Universal Test System (UTS) provides a simple yet efficient way to
perform multiple, advanced test operations in outside plant installations as
well as maintenance and troubleshooting.

The portable FTB-300 UTS combines a powerful platform with a series of
high-performance, field-interchangeable modules. Housing up to three
modules simultaneously, the FTB-300 UTS can integrate most of the
existing outside plant fiber-optic test applications. The system is PC-based
and runs all test applications in the Windows 95 operating system,
providing you with all the processing power required for field testing.

Modularity and Versatility

The main advantage of the FTB-300 UTS modular platform is that it can be
configured to suit your work environment. Field-interchangeable modules
allow operators to modify the test-tool capabilities in a matter of seconds
and as many times as required in a day’s work.

The design of the FTB-300 UTS also provides obvious cost advantages,
since a single test system is shared between many applications. Without
changing the platform, the test system can also be improved with new
modules or software upgrades to provide the latest technologies at a
fraction of the cost.

Test and Data Management

All test applications necessary to operate the FTB-300 UTS modules are
integrated into a single software: ToolBox 5. In addition, FTM software
manages test data in an effective and user-friendly manner.

Universal Test System 1



Introduction
Built-in Field Intelligence

Built-in Field Intelligence

The FTB-300 UTS relies on a powerful central processor to speed up data
acquisition. Therefore, advanced test result analysis, documentation, and
archiving are made possible on location with the test system itself.

The PC-based system runs Windows 95 and supports external peripherals
such as a printer, VGA display, keyboard, and mouse. It can be used to run
most off-the-shelf Windows and DOS software. Hence, the FTB-300 UTS
can replace a portable PC.

The standard hard drive provides internal storage capacity for more than
100 000 fully documented OTDR test results. An internal floppy drive option
is also available.

The FTB-300 UTS can be remotely controlled to save you valuable time.
While installed in the field, the test system can be accessed from another
FTB-300 UTS or from your desktop PC, making it easy to start an
acquisition, adjust test parameters, and download test results.

Compatibility

The FTB-300 UTS is compatible with EXFO’s existing handheld units. Some
handheld power meters or loss test sets can even download data to the
FTB-300 UTS via a serial link, or send messages along the fiber under test.
The FTB-300 UTS is therefore an integral part of efficient fiber-optic testing.

Rugged, Portable Field Unit

The FTB-300 UTS is designed to withstand the worst field conditions. The
unit offers shock-proof casing with protective rubber bumpers to withstand
drops and vibrations; a waterproof outer shell with sealed joints; and
protective panels for connectors, ports and floppy drive.

2 FTB-300



2 Description of the FTB-300 UTS

The compact and rugged FTB-300 Universal Test System (UTS) can house
up to three optical test modules simultaneously. The following pages will
describe the FTB-300 UTS.

Front Panel

Touchscreen

(see Using the Touchscreen
on page 17)

Bumpers

LEDs
(see Bumpers

(see LEDs
on page 12) on page 4)

On/Off

button

Contrast control Brightness control

(not available with
color display)
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Description of the FTB-300 UTS

Front Panel

LEDs

The LEDs on the front panel provide you with the FTB-300 UTS status.

B

On: hard disk drive is being accessed.

(ad

On: floppy disk drive is being accessed (only in
FTB-300 UTS equipped with a floppy disk drive).

On: unit is plugged in and internal battery pack is
charging.

Off: batteries are fully charged (if FTB-300 UTS is
plugged in) or FTB-300 UTS is not plugged in.

On: ten minutes of battery operation left.

On: FTB-300 UTS is turned on.

Flashing: FTB-300 UTS is turned on but in Sleep
mode.

FTB-300



Description of the FTB-300 UTS
Right Panel

Right Panel

The FTB-300 UTS peripheral devices and ports are located on the unit’s left
and right panels. The right panel ports are protected by a door to prevent
foreign substance from reaching the internal components. This panel
provides the input/output connectors and the optional PC Card reader. For
information on installing and removing modules, see Inserting and
Removing FTB Test Modules on page 15.

Test module slots \
.
\\
\\\\
Slot A | Slot B | Slot C
(o o ©
Peripheral ports
P P ~_ | =
With port cover open ™~ .
(see Ports on page 6) I o
.o
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Description of the FTB-300 UTS

Right Panel

Ports

PC Card Reader (optional)

(see Installing a PC Card on page 47).

PCMCIA

KEYBOARD PORT

PARALLEL PORT

Keyboard port

PS/2 connector (see

Installing an External
Keyboard on page 39).

Monitor port

Female VGA connector
(see Installing an
External Display

on page 39).

Parallel port

Female DB-25 connector
(see Installing an External
Printer on page 43).

Serial port

Male DB-9 connector
(see Installing a
Mouse on page 40).

FTB-300



Back Panel

Description of the FTB-300 UTS

Back Panel

The FTB-300 UTS comes with a fold-up support stand, located on the back
panel. Pull it out and down to support the FTB-300 UTS at the desired angle.
When finished using the FTB-300 UTS, squeeze the two middle arms

together and push upwards.

The cover for the peripheral ports is also held open on the back panel.

Release the clip to close the cover.

Universal Test System
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j Fold-up

I

Right-panel

port cover

(shown open)
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This device complies with Part 15 of
the FCC Rules. Operaticn is subject
10 the fallowing two conditions: (1)
this device may not cause harmful
interference, and (2) this device must
accept any interference received,
including interference that may cause
undesired operation
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Description of the FTB-300 UTS

Left Panel

Left Panel

AC/DC
adapter/charger
socket

(see Safety Instructions
on page 11)

Battery

|
@®
\
\

' 8

£z

250 | 28
£y 232
L' — — —285
N =
220
o Z2

[els)

zg

R

v

o

{

~

compartment

(see Battery Pack
on page 12, and
Replacing the Battery
Pack on page 52)

T
]
[
—

AINO
$3143AL1vE HAIN 33N
=

Fan vents

(see Fan Vents
on page 12)

Module retaining
screws

Protective cover for
floppy disk drive
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Description of the FTB-300 UTS

Protective Cover

Protective Cover

Your FTB-300 UTS comes with a protective cover when shipped with the
standard semi-rigid carrying case.

EXFO strongly recommends that you do not discard the protective cover

and that you use it whenever you are shipping or transporting the
FTB-300 UTS.

IMPORTANT

The FTB-300 UTS is shock-resistant, but the touchscreen may be
damaged if it is exposed to sharp or heavy objects during
transportation.

EXFO will not be responsible for any damage incurred to the
touchscreen if the unit is shipped in the semi-rigid carrying case
without its protective cover.

If you received your FTB-300 UTS with the standard semi-rigid

carrying case, but without a protective cover, call EXFO (see
Contacting the Customer Service Group on page 50).

Rigid Carrying Case

This added protection allows safe transportation of the FTB-300 UTS with
all connectors, jumpers, and accessories.
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3 General Safety Information

Safety Conventions

The following conventions should be clearly understood before operating

the unit:

WARNING
Refers to a potential personal hazard. It requires a
procedure which, if not correctly followed, may result
in bodily harm or injury. Do not proceed beyond a
WARNING unless the required conditions are
understood and met.

CAUTION

Refers to a potential product hazard. It requires a
procedure which, if not correctly followed, may result
in irreparable component damage. Do not proceed
beyond a CAUTION unless the required conditions
are understood and met.

IMPORTANT

Refers to any information regarding the operation of
the product which should not be overlooked.

Safety Instructions
AC/DC Adapter/Charger
CAUTION

The following voltage requirements must be met: 15 volts, 3.5
amperes, positive core. Use of higher voltages may damage the unit.

Universal Test System 1



General Safety Information

Safety Instructions

12

Power Supply

CAUTION

The power supply is designed for indoor use ONLY.

Battery Pack

CAUTION

Use NiMH replacement batteries ONLY. Use of other batteries may
damage the unit.

Fan Vents

CAUTION

Leave the FTB-300 UTS fan vents clear of obstructions.

Modules

CAUTION

Do not remove or insert modules when the power is on.

Bumpers

CAUTION

Do not lift the unit by the upper bumper. This could damage the
metallic crossbars built into the bumper.

FTB-300



General Safety Information
Safety Instructions

Storage Temperature

CAUTION

If the unit is stored at a temperature outside of the specified
operating temperature range, let the unit reach operating
temperature before turning it on.

13
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4 Working with the FTB-300 UTS

Turning the FTB-300 UTS On or Off

Turning On the FTB-300 UTS

When the FTB-300 UTS is turned off, hold down the blue power button on
the front panel. The FTB-300 UTS starts in Windows 95, DOS, or the
ToolBox 5 shell, depending on the selected start-up option.

To set a new start-up option, see Changing the Start-Up Operating
Environment on page 31.

Turning Off the FTB-300 UTS

When the FTB-300 is turned on, hold down the blue power button on the
front panel. All open applications will automatically close and the
FTB-300 UTS will shut down.

Inserting and Removing FTB Test Modules

CAUTION

Do not remove or insert modules when the power is on.

Inserting a Test Module
To insert a test module,

1. Lay the module with the protruding edges on a flat surface. The
module identification is on the left side of the module’s front panel.

2. Raise the module so that the protruding edges can be inserted in the
last available grooves at the back of the FTB-300 UTS. The connector
pins should be at the top and the retaining screw hole at the bottom
(see the following figure).
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Working with the FTB-300 UTS
Inserting and Removing FTB Test Modules

=

~«¢— Connector pins

D @ < Retaining
@ screw hole
FTB-7300 e
®

~ - o\|

Note: A protection device has been incorporated into the design of the module to
protect against accidental damage to the fragile connector pins.

3. Insert the top and bottom edges in the grooves of the module
compartment.

4. Push the module all the way to the back of the compartment. The
module will stop when it makes contact with the retaining screw.

Place the FTB-300 UTS so that the left panel is facing you.

6. While applying a slight pressure on the module, turn the corresponding
retaining screw clockwise until it is tight. This will pull the module in to
its “seated” position.

When you turn on the FTB-300 UTS, the start-up sequence will
automatically detect the presence of the module.

16 FTB-300



Working with the FTB-300 UTS

Using the Touchscreen

Removing a Test Module

CAUTION

Do not remove or insert modules when the power is on.

Position the FTB-300 UTS so that the left panel is facing you.

2. Turn the screw retaining the module you want to remove by
approximately half a turn counterclockwise. The module will be slowly
released from its compartment.

Note: You can turn the screw with a slot screw driver or any other flat device solid
enough to turn a screw (such as a small coin).

3. Once the screw is no longer holding the module, place the
FTB-300 UTS so that the right panel is facing you.

4. Hold the module firmly and pull it out.
Using the Touchscreen

Introducing the Touchscreen

The touchscreen simplifies and accelerates testing procedures by
providing immediate access to commands. The screen detects the position
of your finger, activating a ToolBox 5 command, function, or button. The
FTB-300 UTS is available with a color or monochrome liquid-crystal display
(LCD).

Universal Test System 17



Working with the FTB-300 UTS

Using the Touchscreen

Color LCD
The color LCD displays up to 16 colors in high resolution mode (640 x 480).

Monochrome LCD

The monochrome LCD displays up to 16 shades of gray in high resolution
mode (640 x 480).

Setting Brightness and Contrast

The buttons (=0+) and (=#+) respectively adjust the display’s contrast
and brightness. To locate these buttons, see Front Panel on page 3.

Calibrating the Touchscreen
To calibrate your touchscreen,

1. Start the FTB-300 UTS in the Windows 95 environment. For more
information on selecting a start-up operating environment, see
Changing the Start-Up Operating Environment on page 31.

2. From the Start menu, click Settings>Control Panel. The Control Panel
window appears.

3. In this window, double-click on Elo Touchscreen. The Touchscreen
window appears. Make sure it is configured as illustrated.

Touchscreen

— Mouze Button Emulation Mode

= Click an touch

=) Click an releaze Setup...

= Drag
Info...
% Drag, double-click

Help
| Click sound on touches

About...

s |
b |
_ b |
s |

] Cancel ]
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Working with the FTB-300 UTS

Using the Touchscreen

4. In the Touchscreen window, click Calibrate> >.

5. Using your finger, a pencil, or another pointed (but not sharp) object,
touch the three targets when they appear on screen.

Tip: You may choose to touch a point slightly lower than the target’s center to
see your cursor when working with applications.

6. After you have touched the three targets, a Check Calibration dialog
box will appear, asking you if the cursor responds as expected. If you
click Yes, the screen is calibrated and you are sent back to the
Touchscreen window. Otherwise, you are asked to redo the calibration
procedure until you are satisfied.

7. To return to Windows 95 from the Touchscreen window, click OK.
Note: To disable the audio feedback given on contact with the touchscreen,

uncheck the option Click sound on touches found in the Elo Touchscreen
control panel.
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Working with the FTB-300 UTS
Mounting the FTB-300 UTS in a Rack

Mounting the FTB-300 UTS in a Rack

An optional rack mount is available for permanent or semi-permanent
installation of an FTB-300 UTS. You can install the rack mount on any
standard combination-type rack.

Combination-

Side holes Top holding plate type rack
Q
Front holes 9
8]
S
Front
Holding o access
bolt\ : / pete
Q
Q
Rack-mount Side
front face access
hole
Holding
Rack-mount rod
handle
FTB-300 UTS Holding
o bracket
o
Q
Q
(4]
Opening hinges Rack-mount rail

Rack-Mount Dimensions

The rack mount fits in combination-type racks (with holes on the front and
sides). It is 19 or 24 in. wide and 12.25 in. high (7 u). It can fit in racks that
are 12, 16, or 22 in. deep.
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Working with the FTB-300 UTS
Mounting the FTB-300 UTS in a Rack

Installing the Rack Mount

IMPORTANT

It is recommended that two people install the rack mount. One
should hold the mount while the other inserts the different screws. A
Phillips-head screwdriver is required for the installation. The following
instructions are for installation in 16- and 22-in. racks.

1. Insert eight clip nuts (illustrated below)—four on the front holes found
on both sides of the front face, and four on the side holes found on
both sides at the back. These nuts will make it easier to install the
holding brackets on the front face and the holding rods at the back.

Note: On 12-in. racks, holding brackets are found at both ends because there is
no need for holding rods.

2. Position the rack-mount holding brackets and rods in front of the clip
nuts.

3. Insert the Phillips-head screws.
Tip: It is easier to put the rack mount in place by unlocking the rails from the
holding brackets and rods and screwing them in position on the rack

mount itself. Then insert the rack mount by “clipping” it onto the holding
rods previously installed on the combination-type rack.
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Working with the FTB-300 UTS
Mounting the FTB-300 UTS in a Rack

Installing an FTB-300 UTS in a Rack Mount

1. Slide out the rack mount along the rails by pulling on the handles.

2. Unlock the holding bolts found along the inner left and right edges of
the front face.

Captive screw

Top holding plate

Blind hole

Holding
bolts

Front access hole

3. Open the front face.
4. Place the FTB-300 UTS in position, in front of the metal guide.
Note: If modules are installed in the FTB-300 UTS and cables or jurmpers are

plugged into their ports, make sure the cables or jumpers are unplugged
before the FTB-300 UTS is placed in position.

5. Once the FTB-300 UTS is in position, insert the top holding plate in the
“rails” found on the FTB-300 UTS’ top bumper.

At this point, the captive screws found on both sides of the holding plate
should align with the blind holes found on the sides of the mount.
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Working with the FTB-300 UTS
Mounting the FTB-300 UTS in a Rack
6. Gently push and turn the captive screws into the blind holes.
Note: Do not turn the captive screws too tightly.

Plugging in the FTB-300 UTS

While the rack mount is out, plug the optional 48-V power supply! (found
on the left side of the mount) or standard 120-V power supply into the
FTB-300 UTS’ AC/DC adapter/charger socket.

S

| -Captive screw

Power supply
" plug

—FTB-300 UTS

W /A
v/

48-V power
" supply

Note: If the power cable ends used to plug in the 48-V power supply are bare (not
fitted with a plug), you can identify their polarity by looking at their shape,
as shown in the following image.

1. 48 Vdc to 15 Vdc converter

Universal Test System 23



Working with the FTB-300 UTS
Mounting the FTB-300 UTS in a Rack

24

Operating a Rack-Mounted FTB-300 UTS

Once the FTB-300 UTS is installed in the rack mount, you can plug cables
and jumpers into its modules. You can access the modules’ ports through
the side access hole. To do so,

1.

2
3.
4

Slide out the rack mount along the rails by pulling on the handles.
Install the modules and plug in the cables through the side access hole.
Push the rack mount back in.

Perform the tests.

Note: The front access hole is for external cables or temporary connections.

Removing the FTB-300 UTS from a Rack Mount

Slide out the rack mount along the rails by pulling on the handles.

Unlock the holding bolts found along the inner left and right edges of
the front face.

Open the front face.

Unplug the 48-V power supply from the AC/DC adapter/charger socket
and the cables from the connectors.

Note: If modules are installed in the FTB-300 UTS and cables or jumpers are
plugged into their ports, make sure the cables or jumpers are unplugged
before the FTB-300 UTS is rermoved.

5.

6.

Remove the top holding plate by unscrewing the captive screws and
pulling up the plate.

Remove the FTB-300 UTS.

Note: The FTB-300 UTS works outside the rack mount on internal battery supply.
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FTB-300 UTS

Your FTB-300 UTS can run both DOS and Windows 95 operating systems.

Versions of the ToolBox shell prior to 5 are optimized to run on DOS
whereas ToolBox 5 and subsequent versions are optimized to run on
Windows 95. For more information on working with DOS, see Running
DOS on your FTB-300 UTS on page 61.

Note: This chapter assumes that you are familiar with basic Windows 95 and
Windows Explorer operations.

Backing Up the Windows Disk Set

Before performing any tests with your FTB-300 UTS, we strongly advise
you to perform a complete backup of your entire system. This operation
will allow you to quickly resume testing should anything happen to your
system.

To do so,

1. Start the mscsd.exe application from the directory C:\Windows\Options

and follow the simple onscreen instructions.

2. When the application asks you what type of disk you want to create,

select the Complete Windows disk set (29 disks) option. You will have

to insert each disk in turn until the backup is complete.

Universal Test System
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Using Windows 95

To ensure proper operation of the FTB-300 UTS under Windows 95,
perform the following verifications and configurations.

Setting Date and Time

Before testing, you should set the date, time, and time zone on your
FTB-300 UTS.

1. From the Start menu, click Settings>Control Panel. The Control Panel

appears.

Double-click on the Date/Time control panel. The following window
appears.

Date/Time Froperties

Date & Time l Time Zone ]
Date-

O MR E |
12 3 4 5 6 7 : ’ :

1 Time-

g 9 10 12 13 14
18 16 17 18 19 20 A
22023 24 28 26 7 o

23 30 3
13545 =
Current time zone: Eastern D aplight Time
ak. | Cancel | Apply |

From this window, you can set the date, time, and time zone.
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Configuring Power Management

From the Start menu, click Control Panel>Power. The Power window
appears. Make sure it is configured as illustrated in the following figure.

Power Properties

Must NOT Fower ] Digk Orives ] PC-Card Moderns ]
be checked

il Ydindows bo manage power use on this computer

= Prower statu

Current power source: Unknawin

Advanced.

oK | Cancel Lipply

Configuring Display Options
1. From the Start menu, click Settings>Control Panel. The Control Panel

window appears.

2. Double-click on the Display icon. The Display Properties window
appears. Make sure the different pages are configured as illustrated in
the following figures.
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Display Properties Display Properties EHE
Backgiound ]Screen Saver] Appearance] Settings] Background = Scresn Saver lAppearance] Settings]
Eattern Wallpaper Scieen Saver
H PFinstripe ToalBox ﬂ Seftings. . t Frexview ]
Bricks Fied Blocks 0 Pipes =
Buttons S andstone 0 Text o wait [10 3: minutes
EargotNet j d Blank Screen
ICELE Curves and Calors
Edit Fattem... Browse... Fhing Through Space
.ﬁl EYERS Flying Windows
Mystify our Mind
Diplay Tl € Cenler S croling Marauee
oK o] ] Bl ] 0K || Cancel ] Epaly t
Display Properties Display Properties HE
Background] Screen Saver  Appearance ] Settings] Background] Screen Saver] Appearance  Settings ]
Normal  Disabled
Window Text
Message B
tessage Tt
oK
— Color palstte Desklop area————
Less Mare
Scheme:
andard [large] Save bs ] Dielete ] 540 by 480 pirels
Item: Size: Colar: - Eont size
]Desktop ﬂ ] :_I:'J - ]Small Forts ﬂ
: Mormal size (96 dpi)
Eont: Size: Color:
J ﬂ J ﬂ Ll AL 2 I~ Show settings icon on task bar Advanced Properties
ok | Cancel ] Apply ] ok | Cancel ] Apply ]
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Advanced Display Options

Finally, while still in the Settings page, click Advanced Properties. The
Advanced Display Properties window appears. Make sure the settings are
as follows:

Advanced Dizplay Properties HE

Adapter l Monitor] Performance]

ﬁ] Cirruz Logic

Advanced Dizplay Properties

Adapter | Monitor l Performance]

—&dapter / Driver information 2
M anufacturer: Cirruz Logic - Standard WG B40:480
Chip tupe: CL-GDE235 Rew F 3
O ption
[AC type: Internal W i e 5 i
s 3
i 2k Monitor is Energy Star compliant
Saflirmane v 40 I Autoratically detect Plug & Play moritars.
Current files: cirrug, dre, *edd, flatd, sirus. vad v Eeset dizplay on suzpend/resume.
Advanced Display Properties EHE

Adaoter] Monitor - Performance ]

mmil These settings control how Windows uses wour graphics hardware.
They can help you loubleshoot dizplay-related problems.

= Graphic:
Hardware acceleration: Mone — I— Full
R R N

Basic accelerator functions: Llze thiz setting to correct more severe
problems, such as unexpected ermors in programs. OK Cancel Apply

i~ Compatibility
Some programs operate improperly if you da not restart pour computer
when color zettings are changed.
‘Wwhen changing color zettings:
1" Bestart the computer before applying the changes.
" Apply the changes withaut restarting,
% Always prompt before applying the changes.

Qg | Cancel ] Apply ]

3. Click OK to leave the Advanced Display Properties window and Close
to close the Display Properties control panel.

4. Click Yes when the Systern Settings Change window asks you if you
want to restart you computer now. The FTB-300 UTS restarts.
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Running Standard Windows 95 Applications

To run standard Windows 95 applications, the FTB-300 UTS must be started
up in the Windows 95 operating environment to ensure full compatibility
with all possible configurations. Once the FTB-300 UTS is started in the
correct operating environment, you can install and run programs as you
would on any standard PC.

For information on the various FTB-300 UTS start-up options, see Changing
the Start-Up Operating Environment on page 31.

Backing Up Test Data

As with all data stored on a hard disk drive, it is advisable to do a backup on
a regular basis. To do so,

1. Locate the directory where your traces have been saved using
Windows Explorer.

2. Ifyour FTB-300 UTS is equipped with a floppy disk drive, copy this data
to drive A. Otherwise, transfer the data with the Direct Cable
Connection utility (see Transferring Data on page 33).

Creating a Start-Up Disk
To create a start-up disk,

1. From the Start menu, click Settings>Control Panel. The Control Panel
window appears.

2. Inthe Control Panel window, double-click Add/Remove Programs. The
Add/Remove Program Properties window appears.

3. From this window, select the Startup disk tab. Click Create Disk and
follow the onscreen instructions.
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Using the Screen Saver

The use of a screen saver minimizes battery consumption, while reducing
wear on your screen. We recommend that you use the screen saver
provided with Windows 95 in the Display control panel. For more
information on Windows 95 functions, refer to the Windows 95 on-line
help.

Note: The screen saver feature in ToolBox 4.x interferes with operations in
Windows 95. Make sure this feature is deactivated.

IMPORTANT

When reactivating the screen, touch the lower right-hand corner.
Touching elsewhere could inadvertently cause loss of current test
data.

Changing the Start-Up Operating Environment

You can easily change the FTB-300 UTS operating environment with
shortcuts. Shortcuts are small software applications used to set the starting
operating environment.

To start up in Windows 95, DOS, or the ToolBox 5 shell,

1. From the ToolBox 5 shell, return to Windows 95 by clicking on the Quit
Shell button. The Windows 95 desktop appears, displaying the
following three shortcut titles:

» Boot into DOS
» Boot in Windows 95 Explorer
» Boot directly in ToolBox 5.0
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2. Double-click on the Boof into DOS icon to always start in DOS, on the
Boot in Windows 95 Explorer icon to always start in Windows 95, or on
the Boot directly in ToolBox 5.0 icon to always start in the ToolBox 5
shell. A window will appear asking you if you want to restart straight
away.

3. Click Yes. The FTB-300 UTS restarts.

From now on, the FTB-300 UTS will always start in DOS, Windows 95, or
the ToolBox 5 shell, depending on your selection.

If Windows 95 starts in “Safe Mode"”

Your FTB-300 UTS may start in the Windows 95 “safe mode” if the previous
start-up was interrupted. Once Windows 95 has finished its start-up routine
in “safe mode”, shut down Windows 95 with the restart option; the
FTB-300 UTS then restarts in the set operating environment.

IMPORTANT NOTICE TO TOOLBOX 4.X USERS

ToolBox 4.x is not designed to test fiber while in the Windows (3.x, 95,
98) operating system. Unexpected errors could occur that may lead to
loss of data. ToolBox 4.x may be used in Windows if you remove the

test modules before starting the FTB-300 UTS and if you work offline.

Selecting a Start-Up Screen

Note: The Paintbrush software is used in this procedure, but you can achieve the

same results with any other paint software, as long as the dimensions of
the image are the same.

You can change the default image that appears at the start-up to any image
you want (company logo, user name, etc.) using the following procedure:

1. Locate the file named logo.sys in your root directory (C:\) and rename
it prevlogo.sys.

2. Inthe Paintbrush application, open the file you want to use as your
new start-up screen.
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From the Image menu, choose Attributes. In the Width edit box, type
400, and 320 in the Height edit box.

Note: The image will be cropped, not scaled.

4.
5.

6.

In the Units area, select the Pels (for pixels) radio button.

Depending on your image, select Colors or Black and white in the
Colors area.

Save your image as logo.sys in the root directory (C:\). (If you use a
paint program other than Paintbrush, make sure the image is saved in
bitmap [.bmp] format. Otherwise the procedure will not work.) The
next time you start up your FTB-300 UTS, the new image will appear
onscreen.

Note: You can also change the screen that appears when you shut down
Windows 95. To do so, follow the previous procedure, but use the logow.sys
instead of logo.sys file.

Transferring Data

Data can be transferred through the FTB-300 UTS serial port or parallel port.
To transfer data back and forth between your FTB-300 UTS and another
computer (PC or FTB-300 UTS), use the Direct Cable Connection utility
provided with Windows 95.

All the necessary network drivers were installed and configured at the
factory. However, a number of parameters must be set before proceeding
with the transfer.

>

>

>

Universal Test System

To use the Direct Cable Connection utility, you must first exit the
Toolbox 5 shell (the utility is not integrated into Toolbox 5).

For the Direct Cable Connection utility to work, the hard disk (C:\) of
your FTB-300 UTS must be in Shared mode.

You can then start the Direct Cable Connection utility.
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Note:

Sharing Files with an FTB-300 UTS

To activate the file-sharing feature on an FTB-300 UTS,

1.
2.

7.

Exit the ToolBox 5 shell. You will return to the Windows desktop.
Start the Windows 95 Explorer.

In Windows 95 Explorer, select the directory or disk that you want to
share.

From the File menu, select Properties. The Properties window appears.
Click the Sharing tab. The Sharing page comes to the front.

Select the Shared As radio button and the type of access that you want
for your selected directory or drive.

Click OK. The directory or drive you selected is now shared.

Transferring Files Between Two FTB-300 UTS

You must configure one FTB as a Host and the other as a Guest.

1. From the Start menu, click Programs>Accessories >Direct Cable
Connection.

2. Check if the information is correct (Host or Guest, and the
communication port).

3. If the information is correct, click Finish.

Otherwise

4. Click Change.

5. Select Host or Guest, according to the appropriate FTB.

6. Select the communication port.

7. Click Finish.

The supplied null modemn cable, which plugs into the mouse port, should
be used for the transfer. To locate the mouse port, see Ports on page 6.
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Introducing ToolBox 5

ToolBox 5 uses the FTB-300 UTS PC-based architecture to provide
extensive documentation capabilities for all types of test results, as well as
a complete range of utilities. ToolBox 5 is a shell that comes pre-installed in
the FTB-300 UTS but also runs on any Windows 95-supported computer.
Off-line compatibility with Windows NT allows users to work on existing
test results in office computer environments.

An intuitive graphical user interface, illustrated with icons, buttons, and
pictograms, provides quick and direct access to all functions with the
FTB-300 UTS touchscreen. The ToolBox 5 shell can be easily upgraded to
suit future technological developments in fiber-optic test equipment.

The ToolBox 5 shell is an integrated and user-friendly interface that allows
you to easily manage test applications and modules. The main screen
contains function tabs which you use to set various parameters and select
the test application you wish to use.
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Function tabs Help button Quit Shell button

erform test || Wark on results Hilities Setup l About

Slot A SlotB SlotC

OTDR 1550 nrm (SM) Long Ermpty FTB-73228 1310-1550 nm
Range

Fault Locatar Fault Locator

aToR — aTOR

= T mm & (19990908 1714
Slot identification \Battery-level

indicator

Installing ToolBox 5 Applications
If you have to install or reinstall the ToolBox 5 shell or its test applications,

follow the standard Windows 95 installation procedure.

To install from a floppy disk
1. Insert the floppy disk marked Disk I in the FTB-300 UTS floppy disk

drive.
From the Start menu, click Run... The Run window appears.

In the Run window, type a:setup and press <enter>.
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Once this is done, follow the straightforward onscreen procedure. If your
FTB-300 UTS is not equipped with a floppy disk drive, transfer the data from
a computer with the Direct Cable Connection utility. For more information
on this procedure, see Transferring Data on page 33.

To Install Following a Data Transfer

Once the data is transferred to the FTB-300 UTS, proceed as in the floppy
disk installation, but instead of typing a:setup, type the path where the
setup file has been transferred and press <enter>. For more information,
see Transferring Data on page 33.
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6 Using Peripherals with an
FTB-300 UTS

Installing an External Keyboard

When you are required to enter alphanumeric data, a touchscreen
keyboard will be displayed.

However, an external keyboard may also be used. To install an external
keyboard on your FTB-300 UTS, simply connect the keyboard into the
keyboard port. To locate the keyboard port, see Ports on page 6.

Note: It is not necessary to turn off the FTB-300 UTS before connecting the
keyboard. The software will automatically detect the presence of a
keyboard.

The keyboard port can also be used to connect any other PS/2-compatible
device to the FTB-300 UTS.

If a keyboard is connected, the touchscreen keyboard will still be displayed
until you go into the Touchscreen Keyboard section of the Setup page and
select None using the left and right arrow buttons.

Installing an External Display

The FTB-300 UTS supports the use of an external display by providing a
VGA color output signal through its VGA port (this signal can be used with
electronic overhead projectors or other VGA-compliant devices). To locate
the VGA port on the FTB-300 UTS, see Ports on page 6.

To setup an external display,

1.

2
3.
4

Universal Test System

Turn on the VGA display.
Connect the display to the VGA port.
Select the Setup tab from the ToolBox 5 main screen.

In the External Monitor (CRT) section, toggle the button so it reads ON.
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Installing a Mouse

To move the cursor on the screen, you can use the touchscreen, a mouse,
or any other pointing device.

To use a mouse with your FTB-300 UTS, simply connect the mouse to the
serial input/output (DB-9) port. To locate the serial port, see Ports on
page 6.

This port can also be used to connect the FTB-300 UTS to a desktop
computer with a null-modem cable in order to transfer test files from the
FTB-300 UTS to the desktop computer.

Note: Itis not necessary to turn off the FTB-300 UTS before connecting the mouse.
The software will automatically detect the presence of a mouse.

Adding a Printer Port

Before installing the printer driver for the GP-273 printer module, you have
to add a second printer port to the Windows configuration of your
FTB-300 UTS. This operation is performed from the Windows desktop.

To add the printer port,

1. From the Start menu, select Settings>Control Panel. The Control Panel
window appears.

2. Double-click Add New Hardware. The Add New Hardware Wizard
appears. From the Wizard, select the options as illustrated in the
following figures.
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Add New Hardware Wizard

If paur hardware iz already installed, you should have
“windows detect it

wihen Windows detects new hardware. it automatically
determines the curent settings for the device and installs
the comect driver.

Do pou want Windows to search far your new hardware?

™ Yes [Recommended)

Add New Hardware Wizard

Select the type of hardware you want ta install

Hardware types:

B Metwork, adapters
@ Other devices

gt Sound, video and game controllers
(0] System devices -

Add New Hardware Wizard

. Click the manufacturer and model of your hardware. |f your haidware is not
listed, or if you have an ingtallation disk, click Have Disk.

If your hardware is still not listed, click Back, and then select a different
hardware type. To see all hardware choices, click Unknown Hardware,

Manufacturers: todels:

Communications Port
ECF Printer Port

Have Disk...

< Back I Mext > Cancel ]

To continue with other Wizard steps, click Next. When you click Finish at
the end of the procedure, the new printer port is added to your
configuration.

Once the new port has been added to your configuration, you must change
one more setting—the input/output range resource.
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To change the input/output range resource,

1.

2.

From the Start menu, select Settings>Control Panel. The Control Panel
window appears.

Double-click System. The Systerm Properties window appears.
Select the Device Manager tab. The Device Manager page appears.

From the device list, select the LPT2 printer port and click Properties.
The LPT2 Properties window appears.

From this window, select the Resource tab. The Resource page
appears.

Double-click on the Input/Output Range resource and change 0378 to
0278.

Click OK and return to the desktop. The port is now properly
configured and you can add a printer driver to that port.

Installing Printer Drivers

You need to install printer drivers when you want to use an external printer
or a printer module.

To install a driver,

1.
2.
3.

Turn on the FTB-300 UTS.
Insert the floppy disk containing the driver in the floppy disk drive.

In the Windows environment, select Start>Settings > Printer. The
Printer window appeatrs.

Double-click Add Printer. The Add Printer Wizard starts up.

Simply follow the installation instructions. When you are asked to click
the printer model and manufacturer, click Have Disk... and select the
printer driver on the floppy disk you inserted. When asked to select a
printer port, select the LPT2 port you added.
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For more information about adding a port to your Windows configuration,
see Adding a Printer Port on page 40.

The driver is properly installed and ToolBox 5 now recognizes your printer.

Installing an External Printer

To install a parallel printer on your FTB-300 UTS,

1. Connect the printer (or other parallel input/output device) to the
parallel port (DB-25). To locate that port, see Ports on page 6.

Turn on the FTB-300 UTS.

Install the printer driver. For more information about installing drivers,
see Installing Printer Drivers on page 42.

The printer driver is properly installed and ToolBox 5 now recognizes your
printer. For more information on printing from a test application, refer to
the test application instruction manual.

Installing the Printer Module (Optional)
1. Turn on the FTB-300 UTS.

2. Install the printer driver. For more information about installing drivers,
see Installing Printer Drivers on page 42.

3. Shut down your FTB-300 UTS.

4. Insert the printer module in the FTB-300 UTS.

CAUTION

Do not remove or insert modules when the power is on.

5. Turn on your FTB-300 UTS. The new printer driver and printer module
are automatically recognized by ToolBox 5.
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Note: If, for some reason, the printer module is not recognized, il will not appear

in the Perform test tab of ToolBox 5.

The printer module will be present in the list of available printers. For more
information about printing from a test application, refer to the instruction
manual that comes with your modules. For more information on the printer
module, refer to the FTB-300 UTS Service Manual.

Changing the Paper in the Printer Module

To change the paper in the printer module, you do not have to shut down
your FTB-300 UTS.

To change the paper,

1. Lay your FTB-300 UTS on its touchscreen with the top of the FTB-300
UTS away from you.

CAUTION

Make sure the touchscreen is not lying on any sharp object.

2. Lift the metallic latch on the module and pull gently. The printer
module opens. Keep pulling until the printer cradle stops.
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3. Turn the round knob facing you counterclockwise until it comes free.

4. Gently remove the top part of the paper assembly. You should now see
the paper holder, since there is no paper left.

5. Pull the paper holder out of the paper assembly.

6. Insert a new paper roll on the paper holder.
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7. Put the paper holder back as it was before you added the paper roll.

Rubber paper feeder

Correct

8. Slide the paper coming from the bottomn of the roll under the rubber
paper feeder.

Note: If the paper is coming from the top of the roll, this means that the paper
was inserted the wrong way. Flip the paper roll so that the paper comes
from underneath.

9. Put the top part of the paper assembly in its original position and
tighten the round knob back into place.
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10. Slide the paper in the paper guide found on top of the paper assembly
and make sure it comes out correctly from the slit on the front panel of
the printer module.

11. Push the printer cradle back into the module until you hear a clicking
sound. This means the printer cradle is properly locked in position.

You are now ready to print again.

Installing a PC Card

Turn on the FTB-300 UTS.

2. Install the PC Card driver. For more information about installing drivers,
see Installing Printer Drivers on page 42.

3. Insert the PC Card in the PC Card reader. To locate the PC Card reader,
see Ports on page 6.

The PC Card (formerly known as PCMCIA) is automatically recognized.
The PC Card reader found in the FTB-300 UTS supports SRAM and flash
cards for storage of test files, and fax/modem cards.
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7 Troubleshooting

Solving Problems

Problem Cause Solution
No Power Up |The battery pack is Charge the battery pack.
discharged.
Replace the battery pack
with a fully charged one.
Connect the FTB-300
UTS to an external
power supply (AC/DC
adapter/charger).
The FTB-300 UTS is Connect the FTB-300
not connected to an UTS to an external
external power power supply using the
supply. AC/DC adapter/charger.
The external power Make sure the external
supply is unplugged. power supply is plugged
in at both ends.
Unit The FTB-300 UTS was Charge the battery pack.
Turned Off |automatically turned
off because batteries Connect the FTB-300
were too low. UTS to an external
power supply (AC/DC
adapter/charger).
Replace the battery pack
with a fully charged one.
Dim Screen |The Contrast and/or Adjust the Contrast and
Characters |Brightness control(s) Brightness controls.
are not set properly.
The screen needs to Allow time for the
warm up. screen to warm up.
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Problem Cause

Brightness control(s)

need adjusting.

Solution
Blank Screen |The screen saver was |» Check if the Power On
automatically LED is flashing. If so,
initiated. activate the screen by
pressing in the lower
right corner.
The Contrast and/or |» Adjust the Contrast and

Brightness controls.

Contacting the Customer Service Group

If you encounter any difficulty while operating this product, please call
EXFO at one of the offices listed below. Our Customer Service Group is
available in North America from 7:30 a.m. to 8:00 p.m. (Eastern Standard

Time), Monday to Friday.

EXFO Electro-Optical Engineering
(Corporate Headquarters)

465 Godin Avenue

Vanier QC G1M 3G7

Canada

EXFO Europe

Centre d’Affaires Les Metz
100, rue Albert Calmette
78353 Jouy-en-Josas, France

50

1 800 663-3936 (USA and Canada)
Tel.: (418) 683-0211

Fax: (418) 683-2170
support@exfo.com
www.exfo.com

Tel.: 33-1 34 63 00 20
Fax: 33-1 34 65 90 93
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Transportation and Storage

Maintain the temperature range within specifications when transporting or
storing the unit. Transportation damage can result from improper handling.
The following procedures are recommended to minimize the possibility of
damage:

» Pack the product in the original packing material when shipping.

» Store the product at room temperature in a clean and dry area. Avoid
high humidity or large temperature fluctuations.

» Keep the product out of direct sunlight.
» Avoid unnecessary shock or vibration.

For more information on environmental specifications, see Technical
Specifications on page 55.

General Power Information about the
FTB-300 UTS

Your FTB-300 UTS operates on DC power from either its internal batteries
or from an AC/DC adapter/charger. The adapter/charger accepts from 90 V
to 250 V.

The AC/DC adapter/charger provided with your FTB-300 UTS converts AC
power to DC power from a standard power outlet. It plugs directly into the
FTB-300 UTS AC/DC adapter/charger socket, allowing you to use the
FTB-300 UTS even when batteries are low. However, to completely charge
the batteries, the FTB-300 UTS must be powered off.

The FTB-300 UTS comes with two nickel metal hydride (NiMH) batteries
and provides a power conservation system. Having extra batteries on hand
allows you to extend the operating time of the FTB-300 UTS when primary
batteries run low.

You can switch from battery power to the AC/DC adapter/charger or vice
versa without turning off the FTB-300 UTS or losing data.
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Replacing the Battery Pack

The battery LED lights up when batteries are low. Changing the batteries
will reset the battery status indicator. The battery status indicator, found in
the lower right-hand corner of the display when in the ToolBox 5 shell (see
Introducing ToolBox 5 on page 35) displays three question marks when you
are changing the batteries. For Toolbox 5 to give an accurate reading, you
must let the batteries run down completely and then recharge them fully.

To replace the battery pack,
1. Save all your traces.
2. Turn off the FTB-300 UTS.

3. Open the battery compartment located on the left panel of the

L
-
L

4. Remove each battery by pulling its strap.
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Mainframe

Back of the FTB-300 UTS

Positive end

-
I
>— Strap
Sena

Negative end

5. Slide the new batteries into the compartment with the positive end up.
They will not go in completely if inserted incorrectly.

6. Close the battery compartment.

Mainframe

Clean the FTB-300 UTS mainframe regularly to avoid build-up of dirt, dust,
and other foreign substances. To do so, use a cloth dampened with soapy
water, rinse with a damp cloth, and dry.

Touchscreen

Clean the touchscreen with a soft, non-abrasive cloth dampened with glass
cleaner.
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Hard Disk
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Hard Disk

Perform regular hard-disk-drive maintenance to keep the file structure in
order and the disk well optimized.

Defrag

Over time, as applications read, write, and delete files, information stored
on the FTB-300 UTS hard disk drive may become fragmented. To
reorganize the files on the hard disk drive, and thus optimize performance,
you should use the Defrag program once a month. To perform a full
optimization and defragmentation, start up the ToolBox 5 shell and click on
Defrag Disk to Improve Disk Speed found on the Setup page, under the
Recover tab.

You can also run the defragmentation utility directly from Windows 95. To
do so, from the Start menu, click Programs>Accessories>System

Tools >Disk Defragmenter or, from DOS, type defrag at the
CA\WINDOWS > prompt.

Scandisk

Scandisk is a program used to detect errors or bad sectors on a disk drive.
It fixes and saves any bad sector, or marks it as unusable (for future
reference). To execute the program, launch the ToolBox 5 shell and click
on Scan Disk to Remove File Problems found on the Setup page, under the
Recover tab.

You can also run the disk-scanning utility directly from Windows 95. To do
so, from the Start menu, click Programs>Accessories>Systemn

Tools >ScanDisk or, from DOS, type scandskw at the C:AWINDOWS >
prompt.
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9 Technical Specifications

Computer Specifications

Hard disk capacity 2.1GB
RAM 16 MB
CPU Intel 80486 DX4-75

Electrical Specifications

Max. AC input

100-240 VAC,1.5 A, 50-60 Hz

Output current

15VDC, 3.6 A

Overvoltage category

11

Mechanical Specifications

Size (HxWxD)

229x%30.5%x10.1 cm

9x12x4in
Screen size
Monochrome 94 in
Color 8.4in
Screen resolution 640x480 dpi

Weight

6.52 kg/14.35 Ib.
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Environmental Specifications

Operational temperature

-5°C to 50°C (23°F to 122°F)

Storage temperature

-20°C to 60°C (-4°F to 140°F)

Relative humidity

95% non-condensing

Pollution degree

4
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10 Warranty

General Information

EXFO Electro-Optical Engineering, Inc. (EXFO) warrants this equipment
against defects in material and workmanship for a period of one year from
the date of original shipment. EXFO also warrants that this equipment will
meet applicable specifications under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace, or
issue credit for any defective product. This warranty also covers
recalibration during two years if the equipment is repaired or if the original
calibration is erroneous.

IMPORTANT

The warranty can become null and void if

» the equipment has been tampered with, repaired, or worked upon by
unauthorized individuals or non-EXFO personnel,

» the warranty sticker has been removed,

» case screws, other than those specified in this manual, have been
removed,

» the case has been opened, other than as explained in this manual,
» the equipment serial number has been altered, erased, or removed,
» the equipment has been misused, neglected, or damaged by accident.

This warranty is in lieu of all other warranties expressed, implied or
statutory, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. In no event shall EXFO
be liable for special, incidental, or consequential damages.
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Warranty
Liability

Liability

EXFO shall not be liable for damages resulting from the use of the
purchased product, nor shall be responsible for any failure in the
performance of other items to which the purchased product is connected
or the operation of any system of which the purchased product may be a
part.

EXFO shall not be liable for damages resulting from improper usage or
unauthorized modification of the product, its accompanying accessories
and software.

Exclusions

EXFO reserves the right to make changes in the design or construction of
any of its products at any time without incurring any obligation to make
changes whatsoever on units purchased. Accessories, including but not
limited to fuses, pilot lamps and batteries used with EXFO’s products are
not covered by this warranty.

Certification

EXFO certifies that this equipment met its published specifications at the
time of shipment from the factory.

Service and Repair

58

EXFO commits to providing product service and repair for five years after
the date of purchase.

To obtain service or repair for any equipment, follow the procedure below:

1. Call EXFO Customer Service Group. Support personnel will determine
if the equipment requires service, repair, or calibration.

2. If the equipment must be returned to EXFO or an authorized service
center, support personnel will issue a Return Merchandise
Authorization (RMA) and an address for return.
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Warranty

Service and Repair

IMPORTANT

Never send any unit or accessory back to EXFO without a Return
Merchandise Authorization (RMA).

3. If the unit has an internal storage device, do a backup of your data
before sending the unit for repairs.

4. Pack the equipment in its original shipping material. Be sure to include
a statement or report fully detailing the defect and the conditions under
which it was observed.

5. Return the equipment, prepaid, to the address given by the support
personnel. Be sure to write the RMA on the shipping slip. EXFO will
refuse and return any package which does not bear an RMA.

Note: A test setup fee will apply to any returned unit which, after test, is found to
meet the applicable specifications.

After repair, the equipment will be returned with a repair report. If the
equipment is not under warranty, the customer will be invoiced for the cost
appearing on this report. Return-to-customer shipping costs will be paid by
EXFO for equipment under warranty. Shipping insurance is at the
customer’s expense.
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A Running DOS on your
FTB-300 UTS

Running DOS Applications

Since the FTB-300 UTS is built on a PC architecture, it can run DOS
applications.

To access DOS from the ToolBox 5 shell,

1. Click on the Quit Shell button to return to Windows 95. For more
information on the ToolBox 5 shell, refer to the ToolBox 5 Shell and
Utilities Instruction Manual.

2. From the Start menu, click Programs>MS-DOS Prompt or restart the
FTB-300 UTS in DOS using the Boot into DOS shortcut.

You can then install or run your DOS applications as you would on any
standard PC.

Using DOS Commands

The table below contains the most useful DOS commands. Text in

italics must be replaced with the correct name and path. Punctuation
has been omitted unless required in the command. All commands must be

followed by <enter> .

Command Function

DIR To see a list of the files (or test results) that are located
in a particular directory, type DIR. The list of all the
files contained in that directory will be displayed on the
screen, including the name of the file, its extension,
size, and the date and time stamp.

CD\ To go directly to the root directory when you are in a
subdirectory.

CD.. To go to the above directory.
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Running DOS on your FTB-300 UTS

Using a Mouse and Touchscreen in DOS

62

Command Function

CD To change your working directory, type cd directory
name

COPY |To copy selected files from one directory to another,
type copy filename  directory

DEL To delete files, type del filename

MD To create a new directory, type md directory name

RD To delete a directory, first delete all files in the directory
and then type rd directory name

FORMAT A: |To format a floppy disk, type format a:

HELP To display DOS help, type help command name

In DOS, the prompt line indicates where you are. For example, if you see
A:NTRACES >, this means that you are on drive A in the TRACES directory.

In the DOS environment, you can setup the FTB-300 UTS to start directly in
DOS or Windows by typing respectively bootdos or bootwin in the root
directory of the DOS prompt.

Using a Mouse and Touchscreen in DOS

In DOS, it is possible to operate the FTB-300 UTS with a mouse and the
touchscreen at the same time. To do this, the program MOUSE.COM must
be in the DOS directory.

IMPORTANT

If you are using a mouse as a pointing device, the communication
parameters will not be correct for serial transfers or.
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Running DOS on your FTB-300 UTS
Using PC Cards (aka PCMCIA) in DOS

To install the mouse driver in the FTB-300 UTS,

Exit the ToolBox 5 shell and return to DOS.

Type cd\

Type copy autoexec.bat autoexec.bak

Type edit autoexec.bat

Place the cursor at the beginning of the line that reads rem mouse
Delete the rem

When finished, hold the left alt + f. Then press X to exit.

Restart the FTB-300 UTS.

® N O un A W N~

Using PC Cards (aka PCMCIA) in DOS

When the PC Card reader is installed, the following PC cards can be used:
» SRAM cards, to store test files

» flash cards, to store test files

» modem card, to communicate over a standard telephone or data line

The following sections cover driver installation for SRAM cards, flash cards,
and fax/modem cards in the DOS environment. If you are using Windows
95, follow the instructions that will be displayed on screen as the Windows
95 hardware configuration system detects the cards.

Note: In the following sections, punctuation has been removed in the DOS

commands to avoid confusion. If punctuation is included in the text, it is
required to execute the command.
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Running DOS on your FTB-300 UTS
Using PC Cards (aka PCMCIA) in DOS
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SRAM Card and Enabling SRAM Card Drivers

While the FTB-300 UTS is running, insert the SRAM card into the PC Card
reader.

To enable the SRAM card driver,

1.

Plug an external keyboard into the PS/2 port. For more information on
using an external keyboard, see Installing an External Keyboard on
page 39.

Exit the ToolBox 5 shell. For more information on the ToolBox 5 shell,
see Introducing ToolBox 5 on page 35.

At the DOS prompt, type cd\
Type edit config.sys

In the CONFIG.SYS file, enable the MTSRAM.EXE and MTDDRV.EXE
drivers by deleting the rem command in the command lines below.

rem devicehigh=c:\cardsoftimtsram.exe

rem devicehigh=c:\cardsoftimtddrv.exe

Press alt + f to access the File menu, then S to save your changes.
Exit the CONFIG.SYS file by choosing X from the File menu.

Restart the FTB-300 UTS to load the SRAM drivers. A double tone will
be heard. The SRAM card has been detected and communication has
been established between it and the FTB-300 UTS.

If no tone is heard, the PC Card driver may not be installed on the
FTB-300 UTS.

If a single, low frequency tone is heard, communication cannot be
established between the FTB-300 UTS and the SRAM card. The
required PC Card driver may not have been properly installed, or the
SRAM card may be defective.

In all cases, call EXFO. For more information, see Contacting the Customer
Service Group on page 50.
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Running DOS on your FTB-300 UTS
Using PC Cards (aka PCMCIA) in DOS

Flash Card and Enabling Flash Drivers

With the FTB-300 UTS running, insert the flash card into the PC Card
reader.

To enable the flash driver,

1.

Universal Test System

Plug in an external keyboard using the PS/2 port. For more information
on using an external keyboard, see Installing an External Keyboard on
page 39.

Exit the ToolBox 5 shell. For more information on the ToolBox 5 shell,
see Introducing ToolBox 5 on page 35.

At the DOS prompt type cd\
Type edit config.sys

In the CONFIG.SYS file, enable the MTAA.EXE, MTAB.EXE, MTI1.EXE,
MTI2PEXE, MTDDRV.EXE, and SSMSFLSH.SYS drivers by deleting the
rem command in the command lines below.

rem devicehigh=c:\cardsoft\imtaa.exe
rem devicehigh=c:\cardsoft\imtab.exe
rem devicehigh=c:\cardsoftimtll.exe
rem devicehigh=c:\cardsoft\imtl2p.exe
rem devicehigh=c:\cardsoft\imtddrv.exe

rem devicehigh=c:\cardsoft\ssmsflsh.sys
Press alt + f to access the File menu, then S to save your changes.
Exit the CONFIG.SYS file by choosing X from the File menu.

Restart the FTB-300 UTS to load the flash drivers. A double tone will be
heard, indicating that the flash card has been detected and that
communication has been established between it and the FTB-300 UTS.

If no tone is heard, the PC Card driver may not be installed on the
FTB-300 UTS.
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Running DOS on your FTB-300 UTS
Using PC Cards (aka PCMCIA) in DOS

» If a single, low frequency tone is heard, communication cannot be
established between the FTB-300 UTS and the flash card because the
required driver is disabled.

In all cases, call EXFO. For more information, see Contacting the Custormer
Service Group on page 50.

Modem Card

While the FTB-300 UTS is running, insert the modem card into the PC Card
reader. A double tone will be heard, indicating that the modem card was
detected and that communication was established between it and the
FTB-300 UTS.

» If a single, low-frequency tone is heard, communication cannot be
established between the FTB-300 UTS and the modem card. The
required PC Card driver may not have been properly installed, or the
modem card may be defective.

In all cases, call EXFO. For more information, see Contacting the Customer
Service Group on page 50.
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